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DTP in Practice
Studying a set of rules is all very well, but nothing beats practical experience. In this
chapter I shall be taking some examples of simple designs of various sorts and
working through how to put them together. Because of the variety of DTP software
discussed in this book I shan’t describe the use of all of them for all the examples,
but each gets a look in at least once and most of the ideas transfer quite easily.

Headed Notepaper

The first example is simple: a sheet of A4 headed notepaper with a logo at the left
and the address at the right. Figure 10.1 shows the letter heading I shall use. As an
introduction I shall show in detail how it can be prepared with each of the programs.

Acorn DTP

First, it is worth remembering that Acorn DTP is not best used for word processing;
instead it is better to prepare the text separately on a word processor and import it as
a story. That doesn’t make it impossible as a candidate, just a trifle inconvenient.

40 Jedburgh Road

Wimbledon

LONDON

SW19 2RS

Figure 10.1  The letter heading to be incorporated into headed notepaper
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However, assuming that you still intend to go ahead, what is needed first is to set up
a master page containing a large and a small frame and nothing else. The large frame
will be used for the text of the letter (a single column is usual for letters); follow-on
pages based on the master page will hold only the text and the page number (in the
small frame). The pages won’t be bound, so the left and right margins can be equal.

So, starting with a blank document, turn to the master page by clicking on the ‘Go to
page’ option in the Page submenu, make sure you are in frame mode and create two
frames. Figure 10.2 shows the top of the master page, with the two frames and their
sizes indicated. You needn’t worry about the sizes while you are making the frames
because they can be altered afterwards: just double-click on one frame at a time to
bring up the ‘Size and Position’ dialogue box and copy the numbers shown in Figure
10.2. Then click on OK when you have finished each one.

Next you should return to page 1, again via the ‘Goto page’ dialogue box, to set up
two frames, one to go behind the logo and the other for the address. They are shown
in Figure 10.3. Their dimensions are: for the one on the left, horizontal position
0.75", vertical position 1.00", width 4.75", height 1.63"; for the one on the right,
horizontal position 5.50", vertical position 1.00", width 2.02", height 1.50". We shall
see why they are such odd shapes in a moment. Then you will need to create another
frame over the top of the left-hand one to hold the logo itself: this is because of
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Figure 10.2  Most of the Acorn DTP master page for the headed notepaper
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Acorn DTP’s habit of stretching a graphic to fill a frame if you adjust the frame’s
size with the dialogue box. So I am not going to specify a size or shape for this last
frame because your graphic will be different from mine.

For the next stage you will need your logo, which can be a sprite or a Draw file. Just
for now, anything will do, but for a proper job you should take some time to design
something suitable, meaningful and preferably attractive. To load the graphic file
into its frame, stay in graphic mode, select the frame by clicking in it and then drag
the file’s icon to it from the directory display. The logo will appear in the frame,
though probably not quite at the right size or shape, the browser will change its title
from STORIES to IMAGES and will show the name of the sprite or the Draw file
beneath it.

To alter the scale of the graphic just alter the size of the frame with the Select button.
The picture is rescaled to fill the frame exactly: you can elongate or squash it, as well
as making it bigger or smaller. (If you want to change the frame’s size without
altering the scale of the graphic, use the Adjust button instead.) If you are not sure
whether the logo is quite the right size you can come back to it later, once everything
else is in place and the balance is more evident.

For the purpose of this demonstration you can use the address provided. The first
step is to create a paragraph style that will be used for the letter text and then use that
as the basis for the style of the address. Select paragraph mode by clicking on the top
right icon in the control panel, and double-click on the style name BODY TEXT that
then appears with others in the style browser. The dialogue box shown in Figure
10.4 will materialise; the standard default font is Homerton, so click on the word
‘trinity’ to change the selected font. A suitable text size for letters is 12pt on 14,
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Figure 10.3  Two out of three frames added to page 1: one frame to go behind the logo
and the other for the address
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which you achieve quite easily by clicking on the button by ‘12’. This automatically
sets the line spacing to 14pt.

As the letter will use this style throughout, you should alter its own definition rather
than use it as the basis of a new style altogether. The reason for this is the principle
of simplicity: never make things more complicated than they absolutely must be,
because giving yourself more options means that you will take longer to choose
between them. A slower working speed will lessen your enjoyment and (if time is
important) your efficiency.

Next you need to define the text and paragraph margins. Click on the box marked
‘Dimensions’, which will bring up the dialogue box shown in Figure 10.5. Enter the
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Figure 10.4  Setting up the font and size for the body text

Figure 10.5  Specifying the paragraph layout for the body text
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value 0 in the ‘Space above’ box and 0.2 in the ‘First line left indent’ box, leaving
the others set to zero. This will let paragraphs follow on from one another without a
gap between them, and the first line of each paragraph will be indented. At any rate,
that is my personal preference; I feel it gives a polished look to the text of a letter.

The next box on the left, Options, needn’t concern you here: you are unlikely to
want to use a bullet character in your body text, or to alter the hyphenation or letter
spacing characteristics. However, the last box, Format, lets you choose the format of
the text and set any tab stops you may want. Again, my personal choice is for
justified text, but you may prefer flush left. Take my advice and don’t use centred or
flush right for the main text of a letter unless you particularly want to make it harder
for the recipient to read.

Finally, click on OK to apply the options to the paragraph style. Now you can type
the address into the right-hand frame. With the style set to BODY TEXT the type
seems too small, so it will have to be made larger and the lines spaced out more to
give it some emphasis. You will have to do this by defining a new style called
ADDRESS, because you can’t alter the line spacing any other way.

Still in paragraph mode, choose ‘New style’ in the Paragraph submenu to call up a
dialogue box like that in Figure 10.6. Clear the name in the box alongside ‘with the
name’ by using the Delete key (or, better, Ctrl-U) and type in the new name Address
(it doesn’t matter about capitals or lower case). Then click on OK to bring up a
dialogue box similar to that in Figure 10.4, but showing the new style name on the
left.

We want to use Trinity Italic at 14 pt on 20, so click on the button by ‘italic’ on the
right and the button by ‘14’. This will automatically set the line spacing to 17pt;
change it by altering the Leading figure to 20. Nothing else needs to be changed, so
click on OK. To save you time when applying the style it is worth setting up a
function key as a shortcut: just choose the style name from the browser list and find
the ‘Function key’ sub-submenu in the Paragraph submenu, then use the list to
choose the key you want to attach the style to (say F5). 

Because the sample address is only four lines long and the frame is big enough to
take five, the first line should be left blank to balance the address with the logo
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Figure 10.6  Basing a new text style on the body text style
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across the page; however, if your address is five lines long it can start at the top of
the frame. If it is longer than that you will have to put less space between the lines
by changing the leading value in the paragraph style.

So far nothing has happened to the address lines because the paragraph style hasn’t
been applied to them: they are still in BODY TEXT style. Staying in paragraph
mode, click on the first address line (note that its style is highlighted in the browser
list) and then either click on ADDRESS in the browser list or press F5. The font,
size and spacing of that line will change to the new specification. Then do the same
for the other lines.

If the first line is blank and the space above the address seems too large with it in
ADDRESS style, change the line to BODY TEXT style.

Now to explain why the letterhead frames are shaped the way they are: it is simply
to let you place the date at the right of the page, in line with the address. The date
‘rests’ on the right-hand edge of the larger left-hand frame. If you change to text
mode and type it there now, though, it won’t line up with the address (try it and see)
because the left-hand frame’s text repulsion setting is wrong. So select frame mode,
click on the frame, then choose the ‘Repel text’ option in the Frame submenu to call
up the dialogue box shown in Figure 10.7. Change the ‘Horizontal space’ value to
zero, make sure the ‘Repel text this frame’ box is starred, then click on OK.

For tidiness you will need to create a new paragraph style to position the salutation
line (‘Dear ...’) and the recipient’s address correctly, against the left margin. You
may also want to start the first paragraph of the letter in this format, lined up on the
salutation. For this you should once again use BODY TEXT as a starting point, call
the new style NO_INDENT and set the ‘First line left indent’ value (see Figure 10.5)
to zero before clicking on OK. You can allocate a function key to this style as well.

Finally, you should decide where you want to position the ‘Yours sincerely’ and
name lines. For the example they are tabbed out to a position about halfway across
the page, and to do this you need to make one more style based on BODY TEXT
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Figure 10.7  Changing the text repulsion of the frame under the logo
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and called SINCERELY. The ‘Format’ dialogue box is shown in Figure 10.8: just
click on the ‘Table, units:’ button and then on the tab type box for tab no. 1. The
word shown will change from NONE to Left, indicating that it is now a left-justified
tab stop. Next, change the value in the tab position box to 3.5, then click on OK. If
you would prefer the lines to be centred, click on the ‘Centre’ button instead.

Don’t forget to save your document now. The finished letterhead with a short letter
on it should look like Figure 10.9; whether you put the address of the recipient at the
top or at the bottom of the letter (or even at all) is entirely up to you. The first page
needs no page number, so the small frame is off the top of the picture.
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Figure 10.8  Setting up a tab stop in Acorn DTP

Figure 10.9  The finished letterhead in use in Acorn DTP

Impression Publisher Plus DTPbook2



Ovation

Setting up the headed notepaper with Ovation is easier than with Acorn DTP
because the more powerful features of the Beebug software mean less ‘fudging’.

First, open a new blank A4 document by clicking on the Ovation icon on the icon
bar. You will need to define a master page by choosing ‘Show Master Pages’ from
the Page submenu; this will open a new window with a title similar to ‘Master
Document1’. The default guidelines have to be moved, which is done by clicking in
the frame on the master page to ensure that it has been selected, then choosing ‘Page
Guidelines’ in the Page submenu to bring up the dialogue box shown in Figure
10.10. Before you copy the values shown into the boxes, note that the units shown
here are inches, whereas your document will probably have the default, millimetres.
You should therefore change them by choosing the ‘in’ entry from the ‘Units’ sub-
submenu in the View submenu. Now you are spared from making copious
calculations to convert the values, but once you return to the document page you will
have to change the units there as well, in the same way.

Next, resize the frame so that it snaps to the guidelines and use the text frame tool
(the capital T) to create a new, small, frame just above it, as shown in Figure 10.2.
The exact size of the small frame is set by clicking on it and choosing the ‘Modify
Frame’ option in the Object submenu (or by pressing Shift-Ctrl-M). The values you
need are: Origin X 3.84in; Origin Y 0.49in; Width 0.56in; Height 0.31in; Inset 0in;
Outset 0in. Now that the master page has been set up, click on the close icon of its
window to return you to the document page.

Because Ovation doesn’t implement changes to document pages already in existence
when the master page is changed, the page you have just returned to still contains
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Figure 10.10  Altering the page guidelines in Ovation
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only one frame, in the original position. So now you have to make Ovation recognise
the new master page: the simplest way to do this is to delete the page we have by
using the ‘Delete Page’ option in the Page submenu. After clicking on OK and
confirming that you intend the deletion, you will be rewarded with the new master
frames on the page.

Now you can create the two frames for the letterhead. Ovation requires frames for
text and for graphics to be defined as such at the outset, so you will need a graphic
frame for the logo and a text frame for the address. Click on the ‘picture frame’ tool
(the one with the cross through it), click within the large master frame to select it,
and then make a frame towards its top left, about three-quarters of its width. Next,
select the text frame tool and make a smaller frame at the top right of the master
frame. Because both frames were started inside the master frame they are both its
‘children’ and cannot be moved outside it. This is a help in positioning the letterhead
frames because you can drag the outer top corners tight up against the master frame.
For the picture frame modify the sizes as follows: Origin X 0.75in; Origin Y 1in;
Width 4.75in; Height 1.63in; Inset 0in; Outset 0in. The measurements of the text
frame are: Origin X 5.5in; Origin Y 1in; Width 2.02in; Height 1.5in; Inset 0in;
Outset 0in. Once you have taken care of the sizes, the top part of the page should
look something like Figure 10.11. The arrangement of the frames is to allow the date
to be inserted as the first item in the letter, just below the address and aligned with it.

The logo now needs inserting, be it sprite or Draw file. Simply select the picture
frame and drag the file’s icon to it from the directory display. The logo will appear at
the left of the frame, filling it vertically (unless your logo is very much wider than its
height). If you want to make it smaller use Ctrl-<, and if you overshoot you can
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Figure 10.11  Master and letterhead frames in place

Impression Publisher Plus DTPbook2



make it larger by pressing Ctrl-> (these are the comma and full stop keys respect-
ively, but < and > are easier to remember).

Before you type in the address, make sure it will appear in the correct font, size and
leading. Because this set of attributes will be used only once in the document, it is
appropriate to use local styles (that is, what I referred to as effects in Chapter 7)
instead of setting up a paragraph style for the purpose. However, the whole
document will use Trinity rather than Homerton as the basic font, so let us edit the
BodyText paragraph style first, to avoid having to set the font separately in the
address’s style.

Choose ‘Edit Style’ from the ‘Para. Style’ submenu (or press Ctrl-E) to bring up the
Define Paragraph Style dialogue box which, among other things, shows a list of
styles available (only one to start with) and a list of the attributes defined for the
style highlighted in the list. First you should change the font, so click Menu
anywhere in the dialogue box and move across the arrow beside Font. Choose the
name Trinity from the list. Then go to the list by Size and ensure that the entry 12pt
is ticked; from the Style submenu choose ‘Normal Text’, and if you want fully
justified text, click Adjust on ‘Justify’ in the Format submenu so that you can choose
‘Tabs/Indents’ as well, at which point the dialogue box and ruler shown in Figure
10.12 will appear.

You need to define two things with the ‘Tabs/Indents’ dialogue box: the main
paragraph style will have an indented first line, with the normal margins set to be the
same as the frame border (that is, zero left and right indents), and a tab stop will be
needed at 3.5in. The Left Tab button is already selected so click in the ruler, just
above the scale, halfway between 3 and 4: a downward-pointing arrow with a hook
to the right should appear there if you clicked in the right part of the ruler. The
number in the Tab/Indent Position box will tell you exactly where it is. Some adjust-
ment is likely to be needed, so drag the arrow icon (using Select) slowly along the
ruler until the number in the box is exactly 3.5. Then click on the ‘1st Line Indent’
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Figure 10.12  Setting up tabs and indents in Ovation
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button and define a first-line indent of 0.2in similarly. When all is well, click on OK
once to return to the original dialogue box, then again to accept the style definition.

Now to set up the local style for the address: if the cursor isn’t in the address frame
click in it to make it so. From the Size submenu choose 14pt, and type in the ‘40’ of
the address to fix the size (you don’t have to do this, but Ovation sometimes forgets
which local styles have been applied before you start to type). Then double-click on
the 40 to highlight it, choose Italic from the Style submenu (or you can use Shift-
Ctrl-I), and from the Format submenu move across the Leading arrow, delete the
value that is there (probably 20%), enter 20pt in its place and press Return. Then
click after the number 40 to bring back the cursor, and type in the rest of the address.

A four-line address looks too high up the page by comparison with the logo, so put
the cursor at the beginning and add a new line by pressing Return. If your own
address is longer than four lines you can omit the first blank line; if necessary, you
can also reduce the leading after typing the address if it is six lines long, but
remember to highlight the text before changing the value.

There remains only to define one further style before the job is finished: the
recipient’s address, the salutation line (‘Dear ...’) and the first line of the letter will
look tidier if they aren’t indented, so go back to the Define Paragraph Style dialogue
box and click on the yellow ‘New’ box to tell Ovation that you want to create a new
style. Enter the name NoIndent in the box provided and click on OK: the name
NoIndent will appear highlighted in the ‘Para Styles’ list. It is a good idea to provide
your own key shortcut for any style you are likely to use often, and now is the time
to do it: just press a function key (say F2) and as long as it hasn’t already been used
in a different definition the name of the key will be shown in the ‘Key Press:’ box.
Then click Menu within the dialogue box, choose ‘Tabs/Indents’ from the Format
submenu and drag the first-line indent icon back to 0in, finally clicking on OK twice
to finish the job.

The page number will look neater if it is centred, so you will need to return to the
master page and select the small frame. Then apply the style NoIndent by pressing
F2, or whatever key you defined earlier. This will overrule the first-line indent in the
BodyText definition so that when you now choose ‘Centre’ from the Format
submenu the caret will be correctly positioned. If you now press the Insert key and
close the master page window by clicking on its close icon Ovation will auto-
matically add the correct page number in the small frame on all pages except the
first. That is no problem because you won’t want a page number on page 1.

That has completed the task of drawing up the blank document: now save it. To type
a letter from scratch you need only to click on the main text frame and start with the
date (you can use Shift-Insert to save typing), which will perch happily under your
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address. Then press Return and choose paragraph style NoIndent either from the
menu or by pressing your key shortcut. Then you can type the recipient’s address or
a reference number or the salutation, and away you go. After starting the second
paragraph of your letter, which will begin flush left because NoIndent is still
operational, press F1 to format the second and following paragraphs with their first-
line indent. At the end of the letter the ‘Yours sincerely’ line and your name look
good if they are lined up about halfway across the page, which is why a tab stop was
set in BodyText at 3.5in. Just press Tab to get there. If you prefer to centre the lines,
that is fine: choose Centre from the Format submenu, or press Shift-Ctrl-C. A
sample letter is shown in Figure 10.13.

Impression

In this section I shall describe the use of Impression; towards the end I shall explain
how the same letterhead can be prepared with Impression Junior, which doesn’t
have master page facilities.

As with Acorn DTP and Ovation, the first stage is to design a master page that will
contain the text and page number frames. Impression has the added ability to include
page numbers automatically, so you must also take that into account in setting up the
master page. Open a new blank document by clicking on the Impression icon on the
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Impression Publisher Plus DTPbook2



icon bar, click in the frame on the page and then choose ‘View master pages’ from
the Edit submenu (or press Ctrl-F2). Master page 1 is the single A4 portrait page
containing one frame, which will be your main text frame. Click in it to select it,
then press F10 to give you a full-size view of the master page on screen.

Choosing ‘Alter frame’ from the Frame submenu, or pressing Ctrl-F10, calls up the
dialogue box shown in Figure 6.5. The values that you need to enter are: X 0.75in; Y
1in; Width 6.77in; Height 9.36in. The ‘Repel text outside’ button should be selected
and all six numbers below it set to 0in. Then click on OK.

If the figures aren’t in inches in your dialogue box you have two options: either type
the numbers exactly as shown here (followed by the units), or use the Preferences
dialogue box to alter the units in which Impression displays them. If you want to do
the latter, click Menu on the Impression icon on the icon bar, choose Preferences and
scroll down the options until you reach the Units section. Click on the sideways
arrows to call up lists of the units available. You can alter independently the units
used for page operations (such as frame sizes), those used in style definitions
(mainly type sizes and paragraph spacing, which are best left defined in points) and
those used on the text ruler and the page rulers. Once you have changed them to your
satisfaction, click on OK (or, if you want Impression always to start up using these
units, click on Save). The new units aren’t reflected in any dialogue box currently
open, but will be shown next time you open one.

The small master frame, for the page number, is created by choosing ‘New frame’
from the Frame submenu, or by pressing Ctrl-I. To start with, make it any size you
like, but in the general area shown in Figure 10.13, then alter it in the same way as
you did the large frame. Use these values: X 3.84in; Y 0.49in; Width 0.56in; Height
0.31in. As before, set all repel values to 0in and then click on OK.

To make use of the automatic page numbering you need to do two things: define a
main text style and a further style, and put a suitable command in the small frame.

First, defining the main text style: click in the large frame on the master page, then
choose ‘Edit style’ from the Style submenu to call up the dialogue box shown in
Figure 7.6. As you haven’t been using any text styles yet it will be ready to edit
BaseStyle. If the font isn’t Trinity.Medium, click on the sideways arrow by the font
name, slide across the arrow alongside Trinity and choose Medium. Alter the font
size to 12pt; the line spacing will be correct at 14.4pt if the 120% button is selected.
Set the space above and below paragraphs to 0pt. The remainder of the ‘Text’ area
shouldn’t need attention if you haven’t previously altered the default document;
compare them with Figure 7.7 if you have. In the ‘Text format’ area choose ‘Full’ if
you want the text to be fully justified (which I prefer), or ‘Left’ otherwise. Make sure
all the other settings are as shown in Figure 7.7.
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You still have to set the text margins and the indent for the first line, which is done
via the ruler associated with BaseStyle. If the dialogue box is in the way, drag it
aside (it will slide almost all the way off the screen if you want plenty of space). The
ruler will be at the top of the document window and will (unless you have altered the
default document) show various icons along its length. All you need is to set the left
margin, the first line margin and a single tab stop. Click Menu on the ruler’s scale
and choose ‘Enter values’; the ‘Ruler setup’ dialogue box, similar to that in Figure
7.5, will appear. Using the appropriate entries in the dialogue box, set the left indent
to 0in and make the first line margin 0.2in. You can ignore the right margin if it
shows 6.77in, as it should.

Before you can set up the tab stop you will need to remove all the others, at least
those within the 6.77in of the main text frame. The quickest way is to drag the
triangular tab icon from the ruler’s scale back into the box that holds all the different
ruler icons. Do this for all except one of them, which you can then drag to about
3.5in on the ruler. If the ‘Ruler setup’ dialogue box is visible at the same time you
will see the number by ‘Tab number 1’ changing as the tab stop moves. Click on the
number and use it to position the tab accurately at 3.5in. Then click on OK in the
‘Ruler setup’ dialogue box, and again in the ‘Edit style’ one.

If you were to try to insert the page number command now, it wouldn’t fit because
of the indent applied to the first text line: the text associated with the command
would overflow the frame (if you want to try this, do so, but be sure to save your
document first, in case you can’t easily recover from it). You therefore need a way of
preventing the first line from being indented, and you can do this by defining either a
new style or a new ruler. The difference for the present simple requirement is that
you can define a key shortcut for a style but not a ruler; if you expect to use it
frequently, define a style. Let us look at creating a new style with only this one small
difference from BaseStyle.

Choose ‘New style’ from the Style submenu to get the ‘Edit style’ dialogue box
again. Use Ctrl-U to delete the name Untitled from beside Style name and type the
new name NoIndent. Don’t press Return yet because Impression normally takes that
to mean the same as clicking on OK. Instead scroll down the list of attributes until
you reach the ‘Text format’ area, and click on the ‘Alter ruler’ button to make the
text ruler appear. It will have no icons along its scale because no margins or tabs
have yet been defined. Find the bent arrow, which represents the first line margin, in
the box on the ruler and click on it a few times (three times normally does it) until it
becomes highlighted, then click anywhere on the scale to ‘drop’ the icon. Then just
drag it along the scale to zero. Now this one feature, no first line indent, will
override the indent setting in BaseStyle when you apply the style NoIndent. To make
use of the key shortcut facility, scroll to the bottom of the attribute list in the
dialogue box and click in the box beside ‘Key short-cut’; if you now press F9 that
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key will be assigned the style NoIndent as soon as you click on OK, which you can
now do.

Now for the big moment: click in the small frame to put the text cursor in it and
choose ‘Centre’ from the Effect submenu (or press F6) to apply the style Centre,
then press F9 to add the style NoIndent, which cancels the indent in BaseStyle. To
insert the command that will show the page number on each page, follow the menu
path shown in Figure 10.14 and choose accordingly. If you have done everything
right, you will see <pn> appear in the frame. Figure 10.15 shows how far we have
come on the master page.

As you have now finished defining the master page, click on its ‘close window’ icon
and save the document in case of problems with the next stage.

If all is going according to plan you will find a figure 1 in the page number frame;
you don’t really need it on the first page so click on the frame (note that although the
outline turns green there are no handles, showing that it is a master frame) and delete
it with Ctrl-X. (As a long, heartfelt aside: yes, you can delete a master frame on a
text page, which is often very useful – it will appear again on the next page – but it
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Figure 10.14  Setting up automatic page number insertion

Figure 10.15  The top of the completed master page
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can be disastrous if you aren’t concentrating on what you are doing. A moment’s
inattention with the key shortcuts and you can delete the main text frame from a
page in the middle of a long document (using Ctrl-X instead of Ctrl-D, for instance).
Believe me, I have done it half a dozen times while writing this book, and it isn’t
funny having to link up a local frame with the master frame on the previous page so
that the text flows through it again; positioning it accurately and bringing all the
illustration and header frames to the front again is nerve-racking and time-
consuming. Learn from my mistakes and keep your mind on the job!)

Now to create two frames on page 1 of the letter itself: one for the logo and one for
the address. Impression doesn’t distinguish between graphic and text frames
initially; both are created from the same menu option or, for speed, with Ctrl-I. So
make two frames and follow Figure 10.3 to position them roughly where they should
go, then use the ‘Alter frame’ dialogue box to enter the following values for them:

Left frame: X 0.75in; Y 1in; Width 4.75in; Height 1.63in; Repel button
selected; repel right 0.2in; all other repel values set to zero.

Right frame: X 5.5in; Y 1in; Width 2.02in; Height 1.5in; Repel button
selected; all repel values set to zero.

If, when you have finished arranging the two frames, you are wondering why the
frames are stepped like that, the answer is: simply to provide a niche for the date to
rest in, just below and in line with the address.

To add the logo (it can be a sprite or a Draw file) to the left frame, select it and drag
the file’s icon to it from the directory display. It will be shown in its correct
proportions, centred in the frame, at the largest size possible for the size of frame.

For a squarish graphic this will result in a lot of white space to left and right in the
frame, so you will probably want to move it to the left. This is a technique worth
getting the hang of and also keeping in mind whenever a whole graphic frame needs
moving about: to ‘pan’ a graphic within its frame, just drag it. But how does
Impression tell the difference between a drag meant for the graphic within the frame
and one meant to move the frame itself? There are two ways, one of which is more
certain than the other. If you click within a frame and hold down Select for more
than about a second without moving the mouse, the ‘open hand’ pointer will appear,
meaning that the frame is ready to move with the mouse until you release Select.
However, if you move the mouse before the pointer has changed, Impression will
assume you intend to move the graphic rather than the frame, and will continue to do
so until Select is released. To avoid the possibility of a misunderstanding, if you
want to move the frame press Ctrl as you start the drag operation: this will make
your intention clear to Impression by immediately invoking frame movement.
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Having moved the graphic towards the left of the frame, you may find that it is
slightly too large. To make it smaller simply double-click on it, which will summon
up the ‘Alter graphic’ dialogue box illustrated in Figure 10.16. This is used to make
many adjustments to a graphic, but for now just try out different sizes for the logo:
change the percentage shown alongside Scale and then click on OK with Adjust
(rather than Select) to see the result while keeping the dialogue box on screen. When
you are happy with the scale, click Select on OK or press Return. If it turns out to be
the wrong size once the address is in place you can always come back later and
readjust it.

The address lines are going to be in italics, in larger type than the rest of the letter,
and more widely spaced (if there are only four or five lines to it). As this combin-
ation of font, size and leading won’t be needed anywhere else in the document there
is no point in defining a style for them, so effects are the order of the day.

Click in the address frame to give it the text cursor, then via the Effect submenu
choose, in succession, a text font of Trinity.Medium.Italic, a text size of 14pt and a
line spacing of 20pt. To avoid having to call up the menu each time, remember to
click Adjust on the first two choices; the third involves entering a number anyway,
and it is quite natural to press Return afterwards for that, though clicking Select on
the ‘On’ button gives the same result. Then, as soon as the menu has disappeared,
type the address: if you delay or do anything else you may find that Impression has
forgotten about the effects you applied. This isn’t a mistake, it is deliberate – the
effects are only pending, or waiting, until you type at that cursor, but if you select a
different frame before typing anything the effects will vanish because there was
nothing to apply them to while the cursor, or the program’s attention, was elsewhere.

If a four-line address seems too high on the page in comparison with the logo (as it
will be if you started at the top of the frame), add a blank line by pressing Return in
front of it. Now that may place it a little low down, so raise it slightly by removing
the leading from the blank line by highlighting it (see Figure 10.17) and choosing
‘Clear all effects’ from the Effect submenu. The frame is just about right for a five-
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Figure 10.16  Impression’s ‘Alter graphic’ dialogue box
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line address starting on the top line; for six lines you needn’t apply the 20pt leading.
If you have more than six lines in your address, you are on your own!

So now that everything is in place, is it time yet to type your letter? Actually, no:
save this document first, because it will form the template for all your letters.

When starting your letter, to save yourself the trouble of remembering the date,
don’t forget Impression’s ‘Insert current date’ option, which is reached by the same
route as the current page command (see Figure 10.14) or by pressing Shift-Ctrl-D.
Figure 10.18 illustrates a sample letter prepared in Impression. The style NoIndent
was used for the recipient’s address (you may wish to place it at the end of the letter,
or not include it at all, of course), for the salutation line (‘Dear ...’) and for the first
line of the letter, for neatness. All the other paragraphs use BaseStyle; instead of
going through the Style submenu to remove the NoIndent style, press Ctrl-B to clear
all applied styles. Note the use of BaseStyle’s tab at 3.5in to place ‘Yours sincerely’
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Figure 10.18  The finished letterhead in use in Impression

Figure 10.17  Highlighting a blank line: it includes the Return character
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and the name fairly tastefully across the page: to get there, press Tab at the start of
each of the two lines. If you prefer to centre them, press F6 before typing the first of
them.

Impression Junior. In many ways the above description also applies to Impression
Junior, with minor alterations to take account of the reduced specification of the
software. Here I shall simply point out briefly where the differences in procedure
are. The most significant is Junior’s lack of master pages, so let us look first at how
you get round that.

Open a new document and click in the frame; use the ‘Alter frame’ dialogue box to
change its size and position to that of the main text frame. For the page numbers you
can make use of a repeat frame because you want this to appear on each page
complete with its contents. So, create a repeat frame (go via ‘Insert frame’ in the
Frame submenu, or press Shift-Ctrl-R) in roughly the right place and fine-tune its
size and position as above.

To place the page number centrally you don’t need to go through the palaver of
creating a ruler without indents because the text will naturally start flush left unless
you take the step of applying a ruler with indents. Just press F6 to apply the effect
Centre, then choose ‘Insert page number’ from the Misc submenu. That is all that the
master pages were doing in Impression, so now to turn to the frames on the
letterhead page itself.

Create the two frames for the logo and the address, and give them the right positions
and sizes. Drag the logo into the left frame, then move and resize it to your satis-
faction. As the address was defined with effects rather than styles the procedure for
completing the address frame is the same here as for Impression, but there is one
distinct difference: if you enter too many lines in the address frame you will cause a
second page to be created so that the excess can flow into a copy of the frame.
Reducing the leading and/or the point size of the address to let it all fit in the one
frame will get rid of the second page.

There are only two things still to do: alter the text size for the letter, and define a
paragraph indent with a tab stop at 3.5in. To do the former you must first type
something in the text frame and apply the necessary effects to it. So, type a letter A
and highlight it by double-clicking on it, then apply the following effects from the
Effects submenu: Text font Trinity.Medium; Text size 12pt. The leading will be set
automatically to 14.4pt, which is 120% of the text size. Next click in the frame again
to deselect the text. Lastly, the effects must be used to redefine the characteristics of
ordinary text, so from the Misc submenu choose ‘Define plain text’. A warning box
will appear to let you know that what you are about to do is pretty drastic, but take
courage: you know what you are doing, so click on Define. Then delete the A.
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Finally, you need to set up the indent and tab stop, which means editing the ruler
called BaseRuler. Before you can edit it you must apply it at the cursor, so make
sure that the cursor is in the address frame first, because you will also be applying it
to the address. Click Adjust on ‘BaseRuler’ in the Ruler submenu, then choose ‘Edit
ruler’ to summon it up. In Impression Junior you can’t make adjustments to the
positions of the various items on the scale by changing values in a dialogue box, so
you will have to manage by dragging them about on the scale itself. For greater
accuracy you can increase the size of the display to, say, 400% by choosing ‘Scale
view’ from the Document submenu and altering the number in the dialogue box.
Then drag the left-pointing flag to 0, the right-pointing flag to the right of the text
frame and the bent arrow to 0.2in. (You did change the preferences, didn’t you?) Get
rid of all but one of the triangular tab stops, drag the remaining one to 3.5in and
click on OK.

Now click anywhere in the address to place the cursor within it again. Next, select
the whole address (use Ctrl-T as a shortcut) and return to the Ruler submenu. You
will find that the name BaseRuler appears twice in the menu; the upper one probably
has a line by it, meaning that it is applied somewhere within the selected region. To
remove it from where it is applied, click Adjust on it (this leaves the menu on
screen), then click Select on it to apply it over the whole address. That should more
or less finish the letterhead.

But wait: what about the page number on the first page? It doesn’t look right and
shouldn’t be there. Deleting the frame isn’t the answer, because then it won’t appear
on any other page either. The answer is both simple and obvious: concealment.
Create a frame just big enough to cover the repeat frame, then use the ‘Adjust frame’
dialogue box to remove text repulsion from the new frame (otherwise it will repel
the page number completely out of the frame beneath it). Now save the document,
because you have finished preparing the template.

Writing your letter in Junior is a little different from using Impression, for three
reasons: you start typing with no ruler applied; once you reach the second paragraph
you apply BaseRuler (there are no key shortcuts for this); and if you run over onto a
further page, copies of the address frame and the concealment frame will be created
which have to be deleted manually by selecting them one at a time and pressing Ctrl-
X. All being well you will then find the page number revealed at the top of the page.

Business Form (Acorn DTP)

Figure 10.19 shows the next project: a reply form of moderately complex design that
was intended to make it easier for people to submit their learned papers to a
scientific journal (the names given here, incidentally, are bogus). The submission
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Figure 10.19  A reply form designed with Acorn DTP (the original was A4 size)
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process was split into three phases, two of which would be done by the person
sending the paper in and one by the Editor of the journal. The first stage was to tell
the Editor that a paper had been received; second, to let the Editor make a note of the
official reference number for the paper; third, after the referees had reported, to tell
the Editor what a great or rotten paper it was. The aim of the form was therefore to
separate these phases clearly, and make it straightforward to use. It was originally
designed as a multi-copy form of the kind that didn’t need carbon paper, but in the
end it was simply printed regularly in the journal.

The key elements of the design are:

• clear headings identifying the organisation and the purpose of the form;
• prominent information about who it is aimed at;
• a direct appeal to the person filling the form in (saying ‘you’);
• bold separation of the three sections by heavy rules;
• use of larger type for the title of each section;
• restriction of type sizes to two (other than the main headings);
• only one font used, with italic and bold (bold italic only where needed);
• use of first person (‘I’) so that the person filling it in feels involved;
• plenty of space for responses to be written in;
• to fit on A4 paper; and
• extra binding margin on the left.

At the time of preparing the form, only Acorn DTP was available, so that is what we
shall use for demonstration purposes. As the previous example was dealt with in
great detail I shall take things a bit faster this time.

Deciding how to implement the design wasn’t immediately easy, because there were
several different ways it could have been done: for instance, the heading and the
three sections could have been placed in frames of their own, with each section
frame having a border on the top edge to provide the rule between sections; or the
text could have been in one large frame with drawn lines overlying it; or various text
frames and drawn lines could have been assembled piece by piece. In fact I opted for
the last of these because it promised greater flexibility of arrangement and called for
less forward planning (an example of the gulf between preaching and practising).

The document as designed contains a lot of frames all of the same width, so you will
find it very helpful to use a column guide of the right width that they can all snap to.
Starting with a blank document, go to the master page via the Page submenu, then
choose ‘Set column guides’, again from the Page submenu, to bring up the default
dialogue box shown in Figure 10.20. Click five times on the downward-pointing
arrow at the top to reduce the number of columns to 1, then enter these numbers:
Top margin 0.47; Bottom margin 1.19; Left margin 1.00; Right margin 0.50. The
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‘Gap between columns’ number isn’t significant when there is only one column.
Then click on OK, whereupon the dotted green outlines will change to a single
outline. Lastly in this burst of activity, make sure that the ‘Snap to guides’ option in
the Frame submenu is ticked (if it isn’t, click on it).

In the original the text frames were placed one by one as they were filled with text,
and the rules drawn afterwards. We shall still do it this way round, but to save time
Figure 10.21 shows all the frames that there are and lists their measurements. As
frames 2, 5 and 6 are graphics frames leave them until later, but you can create and
position the others all at once or as you go along, just as you please. Make them all
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Figure 10.20  Setting up the column guide(s) in Acorn DTP

Figure 10.21  The frames and their vital statistics (frame 3 extends down to frame 6)
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non-repelling of text (use the ‘Repel text’ dialogue box in the Frame menu) to give
you no worries about unexpected disappearances.

Frame 1. This frame, which doesn’t repel text, contains three paragraphs, two of
them based on a headline style and the third on a separate one to allow appropriate
spacing to be added. The style Headline uses Trinity at 20 on 24pt, with 0.12in space
above, none below and no indents, centred format. This is all right for the first line,
but the second is smaller: once it has been typed in and the Headline paragraph style
applied, use the ‘Font and size’ dialogue box from the Text style submenu to change
the custom size to 16pt. The style for the third paragraph, Use_of, specifies
Trinity.Bold at 12 on 14pt, 0.10in space above, none below and no indents, centred
format. Change the font of the name of the journal by highlighting it in text mode,
then clicking on the text style Italic in the browser; as bold is already part of the
paragraph style the words will appear in bold italic.

Frame 3. This frame extends below frame 4 and in fact includes the text of both
sections 1 and 2, except the line beginning ‘Signed’, which is in its own frame. The
whole of the text is based on a single style, with variations provided by local
applications of font and size. The Body Text style uses Trinity at a custom size of 11
on 14pt, with zero spacing and margins, and justified format. Type the first two lines
in Body Text, then change their size to 13pt and the font to bold or italic where
needed. The line spacing will remain 14pt, which is adequate.

The wider spacing between lines needing a written response is made simply (for this
example) by double spacing, which saved setting up a whole new style. So, after
finishing with the first two lines press Return twice, then choose ‘Normal’ from the
Text style submenu (or press Ctrl-F7) to revert to the basic paragraph style. The
lines of dots are alternate full stops and spaces, and to save typing them in every
time you can highlight a number of them, copy them to the clipboard with Ctrl-C
and paste them elsewhere with Ctrl-P. On the ‘Date received’ line there is no point
in using tabs because (i) it takes time to set them up and (ii) they would only be
needed in this one line; just type three spaces. After entering the ‘Please delete as
appropriate’ line type four Returns (notice that the parentheses are upright even
though the text itself is italic: a touch of class) then change the text font and size to
begin section 2 as for the start of section 1. You should then have just enough room
to type the line for the paper number in normal type after two Returns.

Frame 4. This should be made transparent and placed in front of frame 3. The text
(‘Signed... Name...’) was put in a separate frame purely for flexibility in positioning.
Once again, no tabs were used. Use paragraph style Body Text.

Frame 7. This holds the whole of section 3 except the bottom line. To make the
small space between the section heading and the note you will need to make a new
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paragraph style; call it Note and give it these attributes: font Trinity, style bold; size
11 on 14pt; 0.10in space above; format justified. If it weren’t for the extra space
above it you could simply use a bold text style, of course. The next three non-bold
lines are in Body Text, but the five lines from ‘Recommendation to the Editor’ have
a different style, for neatness. Make a new style called Recommend, based on Body
Text but with a left tab at 3in. Then start typing the first of the five lines, change to
paragraph mode and select Recommend, then go back into text mode and type the
rest of the group (using double Returns between them, as before), pressing Tab
before starting the dots on four of the five lines. In this case the use of a tab is
worthwhile, as it ensures that the dots will start neatly in the same place.

The next line, in italics, isn’t really centred although it looks it: it just has three
spaces at the start. If you wanted to centre it properly you’d have to make another
paragraph style for centring text. This and the last two paragraphs in the frame
should be in Body Text so that the longest one can be fully justified.

Frame 8. This is also transparent and in front of frame 7; to save a little time you
can copy the text from frame 4 into it, then highlight the part you don’t need and
delete it with Ctrl-D. Again, the ‘Date’ portion isn’t tabbed, but positioned with
spaces for simplicity.

Drawing the Lines. Now to put in frames 2, 5 and 6, ready for the graphics. Once
again they should be transparent and non-repelling to text; as they are the last to be
made they are automatically in front of the other frames. By far the easiest way to
put the rules in is to draw just the one and then make copies of the frame: you no
doubt noticed that they are all the same size.

Create frame 2 in the usual way and give it the desired properties, then, while it is
still selected, click on the bottom right icon in the control panel to select graphics
mode. A subtle green grid appears in the frame and the browser changes to a set of
eight icons shown in Figure 8.3, representing the tools at your disposal. The arrow
icon (the editing tool) is highlighted whenever you enter graphics mode, so click on
the line icon to its left.

To draw the line, just position the pointer (which at this stage is a + shape) towards
the left of the frame and drag to the right with Select. If the right of the frame is off
the screen, don’t worry: just stop dragging and scroll the page to the right. When you
let go of it the line acquires a handle at each end, just like a selected frame’s, with
which it can be dragged into its final position. The required position is the full width
of the frame, right up against the top edge, so drag the left end as far upwards and to
the left as it will go, and the right end as far to the right and upwards as possible.
Make sure you have the pointer inside the handle when you start the drag operation,
or else you will draw another line.
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Now the position is correct, but is it the right sort of line? To find out, choose the
‘Line style’ option in the Graphics submenu, which calls up the dialogue box shown
in Figure 10.22. The settings illustrated (black ink, no arrowheads, continuous style,
second thickness) are the normal defaults, and are what you need.

To finish the design, return to frame mode and select frame 2, as you now have to
make two copies of it. Type Ctrl-C to copy it to the clipboard and then Ctrl-P twice
to paste in the two copies, initially at random. Then select them one by one and drag
them to about the right places, finishing the job by double-clicking on each and
altering the values in the ‘Size and position’ dialogue box to those in Figure 10.21.

If you were working on this design from scratch, as I was, you would have two
choices in your work technique: you could use arithmetic and calculate exact
positions for all the frames, text and lines, or you could use an element of trial and
error, getting things positioned more or less correctly and then refining until the
complete document hangs together. Being less than competent at mathematics I tend
to favour the latter approach; it feels more creative but has the drawback that it can
take longer and is arguably less certain. Subconsciously, I suppose, I reject the
notion that design can be reduced to anything as dry or as rigidly defined as
mathematics and ultimately it all depends on what looks good. You may or may not
care for this argument, but if you are willing to spend some time tinkering you may
get some enjoyment out of designing even a fairly pedestrian form such as this.

When you come to make the final adjustments, don’t forget two things: (i) use the
‘Double size’ option in the View submenu for the close-up work (and the ‘Full page’
option to see the overall balance), and (ii) for fine movements of frames around the
page you should turn off the ‘Snap to grid’ facility if you intend to use dragging.
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School Newspaper (Ovation)

One of the most exciting applications of DTP in schools is producing a newspaper,
by the students for the students. The use of DTP techniques makes interesting and
varied publications easy, while maintaining an overall coherence that gives a weekly
or monthly issue a feeling of continuity. In this section we shall look at a completely
spurious example prepared with Ovation, the cover page of which is shown in Figure
10.23. Originally intended as an A4 publication, it takes reduction to the size of this
page quite happily, so with a suitable scaling down of all measurements it would
probably work reasonably well in an A5 format too.

The design is based on the following considerations:

• three-column layout to allow flexibility for text and picture placement;
• inner margin (towards the fold) narrower than outer;
• left and right pages are mirror-image layouts;
• readership: pupils rather than staff or parents;
• authorship: various, with one person acting as page editor;
• duplication method: photocopier capable of taking A3 paper; and
• binding method: loose, folded to A4.

The choice of three columns was to some extent arbitrary and was based on
suitability for reduction so it could be included here; four columns are quite
practicable for A4, especially if type smaller than 12pt is used. The main thing to
watch out for with narrow columns is excessive white space in a line; solve it either
with hyphenation or with the tracking control.

Master Pages. A newspaper needs master pages, and a multi-column arrangement is
easily prepared with Ovation. Open a blank A4 document by clicking on the Ovation
icon on the icon bar, then show the master pages. Alter the figures in the ‘Page
Guidelines’ dialogue box to the following: top margin 25mm; bottom margin 25mm;
outer 20mm; inner 15mm; header 10mm; footer 0mm; columns 3; gutter 5mm. Click
on the ‘Double Sided’ option to select it. This sets up a pair of three-column master
pages with an allowance for a header (for page numbers on later pages) and different
left and right margins that will alternate through the document. The first master page
is the left-hand page (even page numbers) and the second is the right-hand (odd page
numbers). Now drag the master frame on each page to snap to the guidelines.

Setting up page headings can be done now, or you can leave it until you have
designed page 1. You need to use local tab stops to position the various bits and
pieces within the header frame. Click in the header frame on the first master page
and press Shift-Ctrl-Tab to call up the ‘Tabs/Indents’ dialogue box. Then set up a
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Figure 10.23  A school newspaper’s front page prepared with Ovation

As expected, the battle was
hard fought and during the
early part of the match the
scores were kept level,
ending the first half at 4–4.

In the second half, however,
seven of the St Mary’s team
were sent off for unruly
conduct, enim dolor lorem
ipsum sit amet, consectituer
adipiscing nonnummy quis.
Ut wisi enim ad minim sed
veniam nostrud, exerci ullam
corper debit.

Molestie

Lorem ipsum sit amet,
consectituer amet adipiscing
nonnummy quid, wisi enim
ad minim eniosque. Suscipit
lobortis ex nisl ut aliquip, ea
nulla commodo et iusto.

Odio dignissim qui blandit
praesent et luptatem zzril
delenit augue duis dolore te
feugait nulla facilisi.

Duis autem vel eum iriure
dolor in henderit in vulputate
velit esse molestie ipsum
consequat.

Nam liber tempor cum soluta
nobis eleifend option congue
nihil imperdiet doming quod.

by Pat Freeman

PHOTO CONTEST 
RESULTS

The winner of the 12–14s
section of our photo com-
petition was Kris Davies,
whose ‘Don’t bother me
now’, shown above, was
taken while on holiday in
Finland.

The lucky winner will get to
spend a fortnight with the
Norfolk Mountain Rescue
Team.

The other winning photos
form a special supplement to
this issue of St Ethel‘s News
starting on page 10.

by Viv Hall

WE’RE THE CHAMPIONS!
St Ethel’s . . . . . . 19 St Mary’s . . . . . . 6

After four seasons since our last win against St
Mary Loquatious, our gallant team last month
pulled off a magnificent victory to win the Area
Championship.

 INSIDE:  Crab Festival...3   Christmas recipes...5   Puzzle pages...6   Animal corner...8
Photo supplement...10   Exam hints...15   Jokes...18   Letters...20   Cycling results...23

 Issue No. 15 December 1991 30p
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centre tab at the centre point of the frame, which is about 85mm, and click OK. Now
apply font SwissB at 12pt, with both bold and italic styles, press Insert to add the
page number sign (#), then Tab to move to the centre of the frame. Type the name of
the newspaper, St Ethel’s News, at the centre tab.

The second master page is similar except that as well as a centre tab for the name
you need a right tab at the right of the frame to position the page number at the
outside edge of the page. After setting the font, size and styles, type the heading as
Tab-St Ethel’s News-Tab-Insert. Then draw a line across each header frame at a Y
position of 33mm and make each one 0.75mm thick. You should end up with some-
thing like Figure 10.24 for the right-hand master page. Now you can close the master
pages window. You will find that the new three-column format hasn’t been imple-
mented in the document page: delete page 1 to force Ovation to redraw it.

Graphics. The various graphical elements of the page are shown in Figure 10.25,
numbered for convenience of identification. A few words on where they came from
might be appropriate. Item 1 is a Draw file: the words were created with FontFX
(using Warsaw UltraBold) and adjusted in Draw; the cockerel was a piece of clip art
from Midnight Graphics, converted to grey; the border was part of the Draw file but
could just as easily have been applied to the frame. No. 2 was also created with
FontFX (using a Bookman lookalike similar to Bookmark.DemiBold.Oblique) and
modified in Draw by magnifying the bottom line to match the width of the top. No. 3
is a heavily modified sprite based on a scanned coat of arms; some of the elements
are in the original (but differently placed), and the clip-art cockerel was loaded into
Draw and grabbed from screen as a sprite before using the ‘Use sprite as a brush’
facility in Paint to drop it into the crest. The trophy in no. 4 was also clip art. The
tiger in no. 5 was supplied with Tracer (Midnight Graphics) but flipped left to right
in Paint as I thought it looked better facing into the page rather than out of it. The
word in no. 6 was created initially with FontFX then rotated through 45°, turned
white and given a black banner background in Draw.

Masthead. The part of the front page that shows the name of the paper and other
publication information (the masthead) should take up no more than one-fifth to one-
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Figure 10.24  The right-hand master page with its header
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quarter of the page, which puts a limit on how large the title can be. I decided to put
the title in outline type so that it could be fairly large without becoming too heavy
for the rest of the page, and to stop the word ‘News’ from overshadowing the name
of the school even though it is almost twice the size.

To clear a patch of the first page for the masthead, and also to cover up the header
which isn’t needed on page 1, draw a text frame 45mm high that extends the whole
width of the main frame. Now the graphics frames can be drawn in. These are,
respectively, 44mm wide by 45mm high; 93mm wide by 45mm high; and 37mm
wide by 45mm high. All should be ‘children’ of the ‘patch’ frame. The graphics
don’t fill the frames completely and need to be adjusted for size and position
visually, both within their frames and across the page. For coarse adjustment of scale
use Ctrl-< and Ctrl-> and for fine changes use the ‘X Scale’ and ‘Y Scale’ values in
the ‘Modify Picture Frame’ dialogue box. To pan the graphic in the frame drag with
Select; dragging with Adjust moves the whole frame.

Next comes the tinted frame with issue and price details. This runs the whole width
of the master frame and is 10.4mm high; the Y origin is at 71mm and the frame has
a 1mm inset, a 4mm outset and a pale yellow background colour. The frame border
is the basic style, 0.75mm thick.
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The text in the frame is in SwissB at 14pt in bold, left aligned. As with the header
frame, the positioning of the various text elements is with tabs: one centred and one
right aligned, as far to the right of the frame as will work (I found that putting the tab
stop at the extreme right of the frame didn’t work, so I had to pull it back a fraction;
this meant that to balance it a space was needed before the word ‘Issue’).

What you have now you could save as the template document for future use: all
you’d need to change would be the ‘special issue’ flash, the issue number and the
month – and, in due course, the price!

Stories. The main story on the page is in two separate sections: one in a double-
column frame to hold the headline and the first paragraph and the other in the
columns defined by the master page. The double-column frame has inset and outset
values of 1mm; its vertical position is made partly irrelevant by the 4mm outset on
the frame above (the text can’t start higher up the page than 71mm (Y origin) +
10.4mm (height) + 4mm (outset) + 0.75mm (frame border) = 86.15mm, but about
85mm will do. The height of the frame can only be determined after you have
completed the first paragraph.

The headline, which is centred, wants to be bigger than will go on a single line in
normal type (and two lines wouldn’t stretch easily across two columns unless made
excessively big), so to get it all on one line at 36pt the width of the characters is
reduced by taking the horizontal scale down to 70% (use Horizontal Scale in the
Style submenu). This is about the minimum you can go to before a font starts to look
really cramped or skinny.

The scoreline uses four tabs, two left aligned for the team names and two right
aligned for the scores; place them symmetrically with respect to the single columns
underneath. They are at 5.36mm (left), 50mm (right), 65mm (left) and 107mm
(right). The spaced dots are put in manually and are there to lead the eye from each
team to its score. The font is SwissB, size 14pt, style bold italic, format left.

Note the use of larger type for the first paragraph, which cuts down the number of
words to a line and gives better readability, as well as some emphasis.

Before typing in any text, consider whether you want the columns fully justified or
left aligned. I tried it both ways and came to the conclusion that, especially with the
rules between columns, the ragged right margin of left aligned text looked untidy.
With a wider gutter and no rules it might be all right: compare it with the newsletter
example later in the chapter and see how they strike you.

For now, define the BodyText paragraph style as SwissB, size 12pt, 0pt space before
paragraph, 6pt space after, justified. Then, just before you start typing the first para-

DTP in Practice 225

Impression Publisher Plus DTPbook2



graph, set the text size to 14pt. When you have finished that, adjust the frame size to
as small as will permit the last line to show (remember that there is a 6pt space after
the paragraph). Using unindented paragraphs with a space between helps to break up
the text and is in any case a more appropriate look for newspaper stories.

Now you can finish the story by typing in the rest of it in BodyText, putting the
cross-head in bold, centred, and finishing with the byline in italic type, right aligned.
The rubbish in the story (that is, the bit not in English) is a sort of nonsense Latin
used by designers to fill a text area; it is sometimes called body text, which explains
why the basic paragraph style is given the same name.

Positioning the frame for the trophy illustration is a bit of a problem: it could go well
in the first column to balance the picture of the tiger, but I have opted to place it
more or less in the centre of the page as a focal point. That is perhaps a trifle
amateurish, but probably authentic for a school newspaper. Notice that it actually
rises above the top of the first column of text; on the whole I don’t think that matters.

The second story illustrates the use of bold type in the same size as body text to
emphasise the first paragraph. The headline is in 18pt bold, with a horizontal scale of
90%. Notice the en dash (Alt-151) between the numbers 12 and 14, as is proper. For
that matter, observe that the correct ’ sign (Alt-145) appears wherever an apostrophe
or closing quote mark is called for, and that Alt-144 is used as an opening quote.

The ‘Exclusive’ banner on the tiger picture (no. 6 in Figure 10.25) is in a transparent
frame overlying the corner of the tiger sprite’s frame; the corner of the banner is
given its shape by having it cut off by the frame edge. By making the original
artwork extend beyond what is strictly needed for a single application you achieve
some flexibility over which corner you can use it for in future: it would also work in
the lower right corner. If you make another copy of the banner file and rotate the
selected object through −90° (be sure to group the items first) you have something
you could use sometime for the other two corners as well.

Contents List. This is a frame 14mm high at the bottom of the master frame and
extending over its full width. It has inset and outset values of 1mm, and its
background colour is set to black. The text style is bold; its colour is made white
with the Colour dialogue box reached via the Style menu. The items aren’t
positioned by using tabs because there are too many of them (and they would vary
from issue to issue). Instead, use ordinary spaces and full justification. At the end of
the second line, type a space after the last word and then another letter or two:
Ovation will carry them to the next line, overflowing the frame, but with the effect
of justifying the line. In this instance, don’t worry about the white arrow on a black
background at the bottom right of the frame: it won’t be printed. At any other time,
worry like mad about it because it means you have lost text by overflow.
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Rules. The rules could be placed on the master pages, but this wouldn’t be as
flexible as you may need when there are several stories on a page. It is no great task
to draw them as and when you need them. The horizontal (X) position of the start
and end points are 72.7mm and 132mm; the vertical (Y) positions will depend on
what you are doing. Allow a little space between the end of the rule and any
horizontal item. Don’t forget that you can use a horizontal rule to separate stories in
the same column, or to direct the eye appropriately when there are double-column
and single-column stories in the same columns; again, don’t extend them to the full
column width.

You will notice that the contents list includes puzzle pages. Don’t overlook the fact
that Ovation’s ‘Duplicate Line’ facility makes preparing crossword puzzle frames
quite easy.

Finally, a few words on the general design: it has a rather staid appearance. This
results from the conservative use of centring. Use a little more imagination than I
have done and bring it into the modern idiom!

Newsletter (Impression)

The last project in this chapter is a newsletter for graduates of a seat of learning. Its
appearance may be strangely familiar to registered users of Impression. Although the
layout seems complex and the design is perhaps rather ‘noisy’, the underlying page
grid is fairly simple, and the whole thing isn’t all that hard to reproduce.

The main design points are:

• A4 page size;
• three-column grid for flexibility of column layout;
• left and right page grids are mirror images;
• page numbers in triangular pointers;
• circulation to interested readership only;
• authorship: one person or editorial team;
• printing method: preferably laser printer;
• duplication method: litho on A3 paper; and
• binding method: folded and stapled.

Although the main text is in 10pt type ranged left, the narrow columns can still cause
problems with large white areas at the end of lines, so either turn the hyphenation on
in BaseStyle or keep an eye out for places where hyphens can be inserted by hand
(use discretionary hyphens, Ctrl-hyphen, in case you change the text later).

Master Pages. To make it easy to position text consistently throughout the news-

DTP in Practice 227

Impression Publisher Plus DTPbook2



DTP on the Archimedes228

THE CADEMICIAN
The newsletter for graduates of the Rutland Thinking Academy

November � December 1991

Two very important
visitors to the
Academy!

AST month saw the Academy
playing host to two very
special guests � no less than

the Prime Minister and the
Secretary of State for Rutland.

Enim dolor lorem ipsum sit
amet, consectituer adipiscing
nonnummy quis. Ut wisi enim ad
minim sed veniam nostrud, exerci
ullam corper debit.

Lorem ipsum sit amet, lobortis
consectituer amet adipiscing
nonnummy quid, wisi enim ad
minim eniosque. Suscipit ex nisl ut
aliquip, ea nulla commodo et
iusto.

Modestie
Odio dignissim qui blandit

praesent et luptatem zzril delenit
augue duis dolore te feugait nulla
facilisi.

Duis autem vel eum iriure dolor
in henderit in vulputate velit esse
molestie ipsum consequat.

Nam liber tempor cum soluta
nobis eleifend option congue nihil
imperdiet doming quod. Lorem
ipsum sit amet, consectituer amet
adipiscing nonnummy.

For full story see page 2

Treasure Hunters Ahoy
AFTER forty-seven years a long-
standing secret has been brought
into the open and provides a
fascinating new insight into what
happened to one of the ships of
the Spanish Armada.

It all started when some
fragments of a Spanish galleon
were discovered by potholers

exploring a set of caves near the
Academy�s Admin Building. The
two-man team on the unofficial
expedition consisted of Denys
(�Cole�) Sellers and Ian Fisher, who
last month revealed luptatem zzril
delenit augue duis dolore te
feugait nulla facilisi.

More in the next issue.

 C  O  N  T  E  N  T  S

2

3
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6

7

8

9

10

11

12

Special Guests
A visit from the Prime Minister
and our Secretary of State

Honorary Degrees
The Academy honours a play-
wright, a lawyer and Mrs Elsie
Catastrophe of Penge: we ask why

New and Departing Staff
Exclusive coverage of who�s in and
who�s out at the Academy. Hail to
the new Professor of Intriguing
Facts and his secretary, and
farewell to the old ... where are
they now?

New Books
Three new books by Academy
staff reviewed in depth

New Papers
Busy as ever, twelve Academy
students have between them
published 43 papers lately

New Ideas
Interviews with five senior staff
who each claim they are on the
verge of having a new idea

Next Year
A sneak preview of next year�s
final-year examination papers

Years Gone By
Profiles of three of our former
students who have made it in the
real world

Return to Rutland
Come and spend your holidays at
the Academy: a special offer

Sports Centre
The £4‰M Exercise-Your-Mind
centre opened in September

L

Figure 10.26  The front page of a newsletter prepared with Impression
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letter, you will need to set up a pair of master pages containing only guide frames.
Because the text columns are off-centre and other parts of the design extend to
different parts of the page, you will want an extra guide frame to act as an outer limit
for page items.

Open a new blank document by clicking on the Impression icon on the icon bar, then
use the Edit submenu or type Ctrl-F2 to reveal the master pages. Rather than try to
position multiple frames by hand, click Menu on a master page and choose ‘New
master page’ from the Edit submenu to call up the dialogue box shown in Figure
10.27. Although it looks fearsome, it can be taken in easy stages.

The first area is ‘Page size’, which should be set to A4. Next comes ‘Format’, which
is based on portrait (that is, taller than it is wide). So that the left and right pages can
be different, click on the ‘Facing pages’ icon but leave ‘Guttering’ set to zero (note
that this is different from the ‘gutters’ defined in Ovation; here it means an extra
margin allowed for binding). The top and bottom margins are 18mm, the left margin
is 24mm and the right margin is 12mm. This gives the basic asymmetric layout with
the inner margin narrower than the outer. In the ‘Columns’ section, set the number to
3 and the width to 55mm; the ‘Gaps’ value will automatically become 4.5mm.
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Lastly, click on the ‘Guide frames’ icon, because you don’t want ordinary frames on
the master pages, then on OK. A new dialogue box will appear telling you ‘You
have just created master page n’, where n depends on how many other master pages
are in your default document. If you now scroll through the master pages you will
find the new ones at the end, numbered n and n+1, each with three guide frames on.
The larger outer margin will be used mainly for putting page numbers in.

Now you can make one more guide frame on each master page to define the outer
limits. Find ‘New frame’ in the Frame submenu and choose ‘New guide frame’
(typing Shift-Ctrl-G is quicker) and create the frame roughly outside the three guide
columns on the left-hand master page. Choose ‘Alter frame’ in the frame submenu
(Ctrl-F10) and enter the following values in the Position part of the dialogue box: X
5.81mm; Y 12.55mm; Width 197.84mm; Height 276.58mm. Then, after clicking on
OK, copy the frame to the clipboard (use ‘Copy frame’ in the Edit submenu, or type
Ctrl-C) and paste it into the top left corner of the right-hand master page (‘Paste
frame’ or Ctrl-V). This guide frame should be the same size, but the X position
should be altered to 6.35mm to complete the asymmetry, and the Y position is still
12.55mm.

Finally in this session, click Menu on the Impression icon and choose ‘Preferences’.
Scroll down the list until you reach the bottom section and ensure that the ‘Snap to
guides’ option is selected: you will need this in building up the pages. To get back to
the main part of the document, close the master page window by clicking on its close
icon.

If you were expecting to see guide frames on the page now, you will be dis-
appointed. First you have to alter the definition of the current (and so far the only)
chapter so it uses the new master pages. You do this by choosing ‘Alter chapter’
from the Edit submenu, which gives you the dialogue box shown in Figure 10.28.
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Just fill in the number of the new (left-hand) master page you created and make sure
you click on the ‘Starting on right pages’ icon, because the cover page is a right-
hand page, before clicking OK.

Front Page. Let us study the various elements making up the cover page. The most
prominent is the masthead, the title bar of the publication; beneath that on the left is
the lead story with a headline, a dropped capital letter, a bold first paragraph, a cross-
head and a picture; and under that is a second story with a headline and a bold first
paragraph. On the right is a tint panel with the contents list, and alongside that is a
fringe of triangles (rather like arrows pointing to the rest of the publication)
containing page numbers; the parts of the contents list have been carefully edited to
make them line up with the page numbers. Between the major divisions of the page
are rules of different thicknesses.

Masthead. Take a look at Figure 10.29: it may seem like not much more than a
jumble of frames, but consider it logically. There is a graphic frame containing the
big A with a tail, two text frames over it containing the title (except for the initial A
on the second word), a frame holding the date and another for the subtitle of the
newsletter. Any outer edges to the frames are snapped to the outermost guide frame. 

Creating the ‘A’ logo was very easy in Draw: just four lines drawn with the grid
lock on, which were then given a grey line colour and a line thickness of 30 (the line
thickness depends on what scale you draw the original at, of course). Assuming that
you have drawn your own copy of the A with a tail, create a frame on page 1 that
spans the whole width of the big guide frame, starts at its top and is 66mm high (use
the Alter frame dialogue box to check the dimensions) and drop the logo into it. Ugh
– what nasty ragged edges there are at the top and bottom of the A; this is just the
way Draw does its line ends, which only shows for wide lines. Not to worry: double-
click on the frame and use the ‘Alter graphic’ dialogue box to increase the graphic’s
scale until the uneven parts can be dragged outside the frame so that they are hidden.
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The frames for the title of the newsletter were placed initially by trial and error (lots
of both); the small frame ended up as 26mm wide and 19.76mm high (I haven’t
given you the X and Y positions because they are fixed by the guide frame) and the
large one has X at 42.47, Y at 18.5 and a height of 42.89mm. Both should be non-
repelling to text, so deselect the Repel option accordingly (the button should have no
red square).

The title itself uses a special font based on Bodoni Heavy; you can get close to it
with Popular.Bold from the Electronic Font Foundry. To make the letters narrow
enough you can either use the Condensed option under ‘Text size’ in the Effect
submenu (this applies a fixed width:height ratio of 60%) or define a separate style
with the ‘New style’ option in the Style submenu. All it has to do is specify a font
aspect ratio of 50%, which is a better degree of squashing for the title than 60%. If
you don’t feel like thinking up a name for the style it doesn’t matter, because
Impression will do it for you in this case, calling it ‘X:Y 50%’ (unimaginative, but
accurate). Use the Effect submenu to define the font sizes; this saves having to create
a new style for each word. The sizes I used were 56pt and 120pt, but with a different
font you will have to experiment with sizes until the two words look right.

The date frame is 73mm wide and 7mm high. The date is in 16pt Pembroke.Bold,
again defined as effects because they won’t be needed elsewhere, and aligned right
in the frame. Note the use of an en dash (Alt-151) between the months, representing
a range. The subtitle frame has Y at 61.38mm, a width of 137.5mm and a height of
6mm. The text for the subtitle itself is also in Pembroke.Bold, but at 14pt and using
a new style to condense it very slightly to 95% so that it can fit in the space allowed;
the alternative would have been to choose a type size that was 95% of 14pt (which
works out at 13.3pt) but I didn’t want type that small. Incidentally, these frames
should also not repel text, just in case.

That completes the masthead. Because it will hardly vary from issue to issue you can
assemble the frames into a group (I didn’t, to let you see them separately): click on
one of them to select it, then hold down Shift while you click on all the others. They
will acquire green outlines, though no handles. Then choose ‘Group frames’ from
the Frame submenu. When the time comes to change the date you can do this
without ungrouping the frames as long as you don’t need to enlarge the text frame to
do so (you shouldn’t have to because ‘November – December’ is about as long as
dates get): just click in the text to position the caret within it, and edit as normal.

Lead Story. This is in seven frames: one for the headline, three for the dropped
capital, two for the text and one for the picture: they are shown in Figure 10.30. The
most obvious point is that the text uses the first two guide columns, whereas the left
edges of the headline and picture frames extend outside the first text column and are
snapped to the outer guide frame. This adds impact to headlines and pictures.
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Once again, the headline frame was positioned partly by trial and error, though it had
to be big enough to hold three lines of 36pt text (with line spacing automatically at
120% that is three lines at 43.2pt, or nearly 130pt, which is getting on for 46mm). It
is in fact 45.15mm high, with Y set at 92.43mm. The font is Popular.Bold, and for
headlines, which will be needed often, it is worth defining a style (I altered Main
Heading) with that font and size, left aligned and with no left margin or first line
margin on the text ruler. Then type the headline without pressing Return at the end
of each line. If the headline looks too open to you (120% spacing isn’t always
appropriate), reduce the line spacing to 40pt, which will give you a bit more space
between the headline and the text.

Next, make the text frames (we shall deal with the dropped capital shortly). They
snap to the column guide frames; the one on the left has Y set at 139mm and is
43mm high, and the other starts at the same Y value but is 88.4mm high. So that text
can flow from one to the other, click Select in the first, then click Adjust in the
second. If you get it right the second frame becomes selected but the caret stays in
the first. Thereafter, the two frames can be treated as one as far as text is concerned:
try typing a word in the second one when there is still room in the first.

Before you type in the first paragraph of your story, using a BaseStyle defined as
10pt on 12pt Pembroke.Medium with no space above or below paragraphs and a
0.4cm first line margin, define two other styles: NoIndent (as you did for the
letterhead project) and Bold (edit the one in the default document if there is one –
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just change the font to Pembroke.Bold) and apply them both at the caret. Then type
the first word (minus its first letter) in capitals and the rest of the paragraph as
normal.

When you reach the end of the first paragraph press Return and then Ctrl-B, which
will remove all applied styles and leave you in BaseStyle. After that you can
complete the story in your own words, or in mine (don’t try translating it: it is delib-
erate traditional nonsense); for now just type the cross-head on its own line without a
special style.

If the style Sub-Heading is spare (you may have it in the default document) you can
edit it so that it is defined as Popular.Bold font at 14pt on 16.8pt, with 4pt space
above paragraphs and 2pt below, and a text ruler with the left margin and the first
line margin at zero. Otherwise, you need to create a new style and also give it the
key shortcut F2; the style will also be useful in the contents list. Applying this style
to the cross-heading involves selecting not only the word but also the Return
character after it to ensure that the paragraph spacing is correct. You know about
selecting a single word by double-clicking on it; well, triple-clicking selects the
current line and quadruple-clicking selects the whole paragraph (so does Ctrl-@,
which is easier). So Ctrl-@ or four clicks it is: then press F2 to apply the style.

For the last line, the reference to page 2, use the Effect submenu to change the font
to Pembroke.Medium.Italic and the format to right aligned.

The frame for the picture is defined with Y at 185mm and a height of 40.6mm; it
also has a border all round, number 1 (this is changed via the ‘View’ dialogue box –
see Figure 6.5(d)). If you don’t have a picture of a bandit on a horse, use something
else appropriate.

ropped Capital. As you can probably see from Figure 10.30, the dropped
capital effect is achieved with three frames. In fact there are two ways of
doing it: I shall show you the harder one; you can work out the easier one for
yourself (hint: use FontDraw). If you try to overlay a large capital letter onto

the start of a text passage using only one frame, you will quickly find that the two
requirements for the frame are mutually exclusive: (1) it must be big enough to hold
the capital, and (2) it must repel the text underneath. But the frame needs to be much
bigger than the letter to allow the full point size (including the descender, remember)
to fit into it, and this makes for a big gap below the letter in the lines after it. The
start of this paragraph shows this effect for a 36pt capital. I have outlined the frame
to show how big it is, even when it is as small as I can make it, and it isn’t small
enough: the fourth line of text should start at the left margin.
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It is therefore no use expecting the frame containing the capital to repel the text
itself. This should suggest to you that the repulsion has to be done by a separate
frame, placed over the text (to repel it) but under the capital letter (so that isn’t
repelled). And that is exactly right: create a frame big enough to hold the large
capital, make it non-repelling and transparent (because it will overlie some of the
text) and type the letter into it (use the Effect submenu to get the font and size right).
Then create a smaller frame that is just larger than the capital and place it over the
part of the text where the capital will go. If you already had the capital there – oops,
it has gone, repelled away by the new frame. No problem: just select the capital’s
frame and bring it to the front with the option in the Frame submenu. With a little
adjustment it should all fit together perfectly.

The third frame in Figure 10.30 comes about because of the odd
shape of the letter L: there are two repelling frames under the
capital, allowing the first line of text to flow back a little. The
whole scheme is shown enlarged alongside.

If you intend to make regular use of dropped capitals in a single
size and font, why not set up a whole alphabet of them beforehand
in a special document, grouping the frames of each so each one can be cut and
pasted quickly into your newsletter when you need it?

Second Story. The second story is constructed in much the same way as the main
one; I leave the details for you to work on.

Contents List. The contents list is slightly more complicated than it might appear:
look at Figure 10.31, which shows the construction of the top of the list; the text
frame for the contents list itself is selected. Let us dissect some order from the
apparent confusion.
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Behind everything is the tint panel: this is a text frame that is 1mm wider on both
sides than the guide frame, to give a border around the contents text. It has a 1mm
horizontal inset so that the word CONTENTS (which is in 15pt Popular.Bold with
two spaces between letters) lines up with the list below. The frame starts at the
bottom of the largest masthead frame and goes down to the bottom of the large guide
frame. With ‘Snap to guides’ selected you can’t easily drag the frame to within 1mm
of the vertical guides, so use the ‘Alter frame’ dialogue box to change the Y origin
and width.

Next come the set of graphics frames holding the triangles: the graphics were
prepared in Draw using an isometric grid (resulting in perfect equilateral triangles,
for those who have done geometry). A little calculation tells you that there is
17.19mm between the right edge of the tint panel and the edge of the large guide
frame, and you have something like 205mm to divide up between 11 graphics,
which works out at 18.63mm each. So make a frame 17.19mm wide and 18.63mm
high, with X at 187mm and Y at 84.2mm, and drop your triangle into it. You will
need to drag the triangle to the left so that it marries up to the edge of the tint. Now
copy the frame with Ctrl-C and paste it in 10 times, working down the edge of the
tint panel and making the top of each one start exactly where the one above finishes.
The guide frame will help you get the horizontal position right. You should find that
the bottom triangle just reaches the bottom of the tint frame; if it doesn’t, work your
way back up the page and look for mistakes. If you can’t find any, work closer: use
Shift-F12 to double the scale (Shift-F11 halves it again when you have finished). As
a last resort you can make a multiple selection of all the frames (Shift-click,
remember) and move them all upwards or downwards at the same time.

The page numbers come next: these are in a single text frame that extends into the
tint frame, but it doesn’t show because it has been made transparent. The numbers
must be in a bold font to stand out clearly; I used the Bodoni Heavy equivalent, so
you will have to find an alternative. Select the frame to get the caret in it, and apply
style NoIndent. From the Effect submenu choose: text size 18pt; line spacing
18.63mm (this is the height of each frame, remember, but you don’t have to work
out the equivalent in points: just type the unit too and Impression will do the
conversion); text colour white; and centred alignment. Then just type the numbers,
pressing Return between each. I shall let you sort out for yourself the X and Y
positions for the frame to give the best centring of the numbers in the triangles.

Nearly there now: the last item is the contents list frame itself. This is a standard-
width column starting just below the word CONTENTS and running to the bottom
of the tint panel. You will need to make it transparent so that the tint shows through,
and the page numbers have moved to the right because of text repulsion, so stop the
frame from repelling text.
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Lastly, use the styles Sub-Heading and BaseStyle to complete the contents list.
Notice how you can make contents descriptions stretch over two triangles if what
they describe is on two pages.

It might not be possible to position the contents items exactly opposite the triangles,
so you may need an extra style that merely sets the font size at 3pt. If you apply such
a style at the start of a line and press Return you will add 3pt of space; if, instead,
you do so with the caret at the end of a line something else happens: try it and see.

Rules. The last part of the job is to add the rules between stories and columns. The
main thing is not to make them too heavy and to prevent them from getting too close
to each other in case they appear to touch, which can look clumsy. In my early work
I always used to create rules by using a border on one side of an otherwise empty
frame, but the drawback of this is that you are restricted to the border thicknesses
provided by the software. It is better to make your own rule by creating a long thin
frame and giving it a black background, because then you have complete control
over the rule thickness (down to a very small fraction of a point if you can print
something that fine). That is how the rules for this project were made. For the record,
the three rules have the following dimensions:

• top horizontal: X 6.35mm, Y 85.65mm, width 117.5mm, height 2mm
• bottom horizontal: X 4.94mm, Y 228.46mm, width 119mm, height 1.2mm
• vertical: X 128mm, Y 90.16mm, width 0.2mm, height 198.96mm

The Rest of the Newsletter. From here on what happens is pretty much up to you.
There is a fancy design feature in the original from which this design was adapted:
each page number is on an inward-pointing triangle at the same vertical position as
the corresponding number against the contents list. You could try doing this as a first
step to filling the rest of the publication.

Printer Type. The whole page was designed with a laser printer (actually a Laser
Direct) in mind. As a result the white border is quite small; far smaller, in fact, than
can be achieved with, say, a dot matrix printer. This is because of the print border at
the edge of the page, within which the printer is unable to print: laser printers have a
smaller border than dot matrix ones. So you will have to adapt the design if you
want it to print out successfully with a different printer type.
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